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Chapter 1   What can RecoverSoft™ Data Rescue PC do for you? 
 
1.1 Program Capabilities / p.3 
1.2 Trial Version / Registered Version Capabilities / p.3 
 
1.1 Program Capabilities 
 
Unlike Windows® dependent data recovery software, RecoverSoft™ Data Rescue PC does NOT 
require the Windows operating system to run. This means, NO software installation, computer 
disassembly or boot diskettes are required to set-up and run RecoverSoft™ Data Rescue PC.  
 
Simply, insert the RecoverSoft™ Data Rescue PC  CD and reboot your computer. RecoverSoft™ 
Data Rescue PC automatically and safely boots from the CD to access your media, even when 
you cannot boot to the Windows® desktop. RecoverSoft™ Data Rescue PC then guides you to 
scan the problem media, select the files to recover, and recover the files to an external USB / 
Firewire device (or hard disk drive). 
 
Second, RecoverSoft™ Data Rescue PC recovers files when a file or file system has been 
altered, deleted, lost or damaged. Undelete Software cannot recover files when the file system 
has been altered, deleted, lost or damaged by Windows®, a virus, or another utility. 
 
Why choose RecoverSoft™ Data Rescue PC? 
 
Recover deleted, lost and damaged files: 
• Word, My Documents, Excel, etc. 
• Pictures, videos, and music 
• Formatted drives, even after installing Windows 
• Virus attacks, software crashes, power failure 
Recover files from partition / file system problems: 
• Lost or deleted partition: FDISK, etc. 
• File from Damaged Partitions: MBR, MFT, Root, etc. 
• Clone – extracts raw data from mechanically failing drives on any media or operating system, 

keeping drives out of the clean room. It also creates sector copy to another media or network 
for back up protection. 

 
Expanded Features: 
• Quick Scan for faster use 
• Preview files before recovering 
• Find specific files, filter files and file systems to refine results 
• View file system information / changes 
• Create file recovery reports 
• Show detailed file system component changes 
• Plug-n-Play: Recover to USB / Firewire without hard drive installation 
• Raw Data Scan now gives an option to rebuild files according to their file types 
 
Supports: 
• All Microsoft® Windows® file systems: 2003, XP, 2000, NT, ME, 98, 95, 3.x and DOS 
• Hard drives: (IDE, EIDE, SCSI, ATA, SATA), Zip / Jaz drives, Floppy diskettes, Firewire / 

USB devices: Compact Flash, Microdrive, Smart Media, MultiMedia, Secure Digital, Memory 
Sticks, XD-Picture Cards. 

 
1.2 Trial Version / Registered Version Capabilities 
 
The Trial Version of RecoverSoft™ Data Rescue PC allows you to rebuild any DOS and 
Windows® file system, so that you can see which files and folders can be recovered, before 
purchasing the program. Each file is given a specific “Status”, which determines the rate of 
recovery. The Registered Version of RecoverSoft™ Data Rescue PC, a purchased copy of 
RecoverSoft™ Data Rescue PC, allows you to recover files and folders to another destination. 
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Chapter 2 Download, Burn a bootable CD 
 
2.1 Download / p.5 
2.2 Burn a bootable CD / p.5 
 
2.1 Download 
 
Download RecoverSoft™ Data Rescue PC online: http://www.RecoverSoft.com
 
2.2 Burn a bootable CD 
 
1. If you are downloading to Windows XP or Windows 2003, then download the file ending in 

RecoverSoftDRPC.exe and save it to your desktop.  
2. Double-click RecoverSoftDRPC.exe on your desktop and this will launch the RecoverSoft 

Data Rescue PC CD Writer. The screen will say, “This program will create a bootable 
RecoverSoft Data Rescue PC CD. To proceed, you will need a blank recordable CD, and 
your computer must be equipped with a CD Writer. This program is compatible with Windows 
XP or 2003 only. If you have an earlier operating system, or do not have a CD writer and 
blank CD, press ‘Cancel’ to exit.” 

3. Click ‘OK’ to continue. 
4. WinZip Self-Extractor – RecoverSoftDRPC.exe screen will appear. It says, “To proceed, 

make sure there is a blank CD in your CD writer, then click ‘Setup’, or click ‘Cancel’ to exit. 
5. This will now create a bootable CD. 
6. Insert the RecoverSoft™ Data Rescue PC  CD into the failing computer as soon as the 

computer starts booting, so that the computer boots from the RecoverSoft™ Data Rescue PC 
CD (If the computer has already been booted, insert the RecoverSoft™ Data Rescue PC  
CD, and then reboot the computer). 

 

http://www.recoversoft.com/
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Chapter 3 Purchase, Registration, and Technical Support 
 
3.1 Purchase / p.6 
3.2 Registration / p.6 
3.3 Technical Support / p.6 
3.4 ACR Data Recovery™ Services / p.6 
 
 
3.1 Purchase 
 
Purchase RecoverSoft™ Data Rescue PC online: http://www.RecoverSoft.com. 
 
3.2 Registration 
 
Online Registration: a serial number is sent via e-mail after your purchase.  
Phone Registration: 1-800-4-PROSOFT (if you only have one computer). 
Registration Hours: Monday – Friday 8:00 A.M. – 5:00 P.M. (P.S.T.) 
   
3.3 Technical Support 
 
Support is available before and after you purchase any of our products. Visit our website for the 
most current Downloads, Manuals, and Frequently Asked Questions: 
 
Website: http://www.RecoverSoft.com  
Frequently Asked Questions (FAQ) – See Chapter 6.   
Phone: 1-925-426-6306. 
Technical Support Hours: Monday – Friday 8:00 A.M. – 5:00 P.M. (P.S.T.). 
 
3.4 ACR Data Recovery™ Services 
 
If RecoverSoft™ Data Rescue PC cannot access or recover your data, your media has severe file 
corruption or is mechanically failing (software will not solve your problem at this point). This 
means, your Drive should be evaluated by professional data recovery personnel. RecoverSoft™ 
recommends contacting ACR Data Recovery™ for In-Lab Data Recovery Services. Visit their 
website for more details: http://www.ACRdatarecovery.com, or contact them by telephone:  
1-800-444-3225 or 1.770.925.4420. 
 
 

http://www.recoversoft.com/
http://www.recoversoft.com/
http://www.acrdatarecovery.com/


 6

Chapter 4 Computer Set-up 
 
4.1 System Requirements / p.7 
4.2 BIOS Settings / p.7 
4.3 Languages / p.7 
 
 
4.1 System Requirements 
 
Minimum: 
PC with CD-ROM 
64MB of RAM 
Intel Pentium 2 Processor 
Monitor resolution 800 x 600 
 

4.2 BIOS Settings 
 
All computers have a BIOS to help computer software communicate with computer hardware. 
The computer BIOS must be set to boot from the CD Drive so that RecoverSoft™ Data Rescue 
PC can communicate with the computer hardware. If you have problems setting the BIOS refer to 
your computer manual. 

4.3 Languages 
 
English is the standard interface language in RecoverSoft™ Data Rescue PC.  
 
RecoverSoft™ Data Rescue PC may also run in German or Japanese by pressing F2 on the 
initial Select Resolution screen, then use the up and down arrows to select the appropriate 
language, and then press <ENTER> to continue. If you purchased the software in the German or 
Japanese markets, then the program will default to German or Japanese. 
 
Files and folders can be viewed in English, German, Spanish, French, and Portuguese, without 
having to make any changes in the Language Set-up. To view files and folders in other 
languages, click [File > Preferences] from the Menu Bar, and then enter the appropriate Drive 
Local and Language. 
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Chapter 5 Running RecoverSoft™ Data Rescue PC  
 
5.1 Launch the Program / p.9 
5.2 Select Program Mode / p.9 
5.3 Select Source Drive / p.10 

a. Choosing Quick Scan or Complete Scan / p.10 
5.4 Select Destination Drive / p.12 
5.5 Network Setup / p.14 
5.6 Scan Source Drive / p.15 
5.7 Select Partition / p.16 
5.8 Raw Sector Recovery / p.16 
5.9 Recovering Files and Folders / p.18 
5.10 Accessing Recovered Files and Folders / p.20 
 
 



5.1 Launch the Program  
 
1. Insert the RecoverSoft™ Data Rescue PC  CD as soon as the computer starts booting, so 

that the computer boots from the RecoverSoft™ Data Rescue PC  CD (If the computer has 
already been booted, insert the RecoverSoft™ Data Rescue PC  CD and then reboot the 
computer). 

 
Having problems booting into RecoverSoft™ Data Rescue PC? See 
Chapter 6, FAQ: 
1. “What do you mean by setting the BIOS to boot from the CD Drive?” / p.18 
2. “If I have a problem, is there technical support?” / p.18 

 
Language Set-up: English is the interface language in RecoverSoft™ Data 
Rescue PC. However, files and folders can be viewed in English, German, 
Spanish, French, and Portuguese, without having to make changes to the 
Language Set-up. To view files and folders in other languages, click [File > 
Preferences] from the Menu Bar, and then enter the appropriate Drive Local 
and Language. 

 
 
2. It is recommended you use the Clone feature if your drive is mechanically failing. The Clone 

feature will allow you to Clone your “bad” drive to a “good” drive, then scan the “good” drive 
for the data you wish to recover, leaving your “bad” drive intact. 
 
To access the Clone feature you must first close the active window (i.e. Select Program 
Mode/Select Source Drive). Next, go to the Recoversoft Data Rescue PC menu bar and 
select Tool (alt T) then Clone (alt C). Choose your Source and Destination drive to being the 
Clone Process. 
 
NOTE: The Destination Drive must be the same size or larger when using Clone. If it is not, 
only a partial clone will be made. 

 
 
5.2 Select Program Mode 
 

 
 
3. Select [Standard] or [Advanced] Mode by clicking on the appropriate radio button. 
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Select Program Mode F1 Help: 
 
Standard Mode and Advanced Mode produce the same results. Read the following details of how 
they differ: 
 
Standard Mode: defaults to scan the entire Source Drive (the problem Drive). It does not 
automatically allow you to select a Partition within the Source Drive to scan, although the choice 
is available. Selecting a Partition gives the option to select optional scan modes, like [Quick Scan] 
or [Complete Scan] of the Partition, which could reduce the amount of time to recover data. If the 
results of a Partition Scan are not what you expect, restart the [> Wizard], and then select the 
entire Source Drive to scan (not just the Partition). 
 
Advanced Mode: defaults to scan the entire Source Drive or a Partition within the Source Drive. 
Advanced Mode also allows you to modify the scanning positions and view the detailed file 
system component information. 
 
Preferences: by default the program scans the Source Drive for English based file and folder 
names. Click on the arrow to the left of "Preferences" and use the dropdown box to choose a 
different language character set to look for (ie. English, European, Japanese, Russian, Chinese). 
 
 
5.3 Select Source Drive 
 

 
 
3. Select the drive that has the data you want to recover.    
 
 
Select Source Drive F1 Help: 
 
1. Choosing Quick Scan or Complete Scan. 
2. If the Source Drive is not recognized, but is attached to the computer. 
3. If you forgot to attach the Destination Drive before starting the program. 
____________________________________________________________ 
 
1. Choosing Quick Scan or Complete Scan 
 
By default, the first available Drive is selected as the Source Drive (the problem Drive). If the first 
available Drive is not the Source Drive, click on the appropriate Drive. 
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Standard Mode does not automatically allow you to select a Partition to scan, although the choice 
is available. To select a Partition, click the [ > ] icon next to the Source Drive and select the 
appropriate Partition. Selecting a Partition gives the option to select optional scan modes, like 
[Quick Scan] or [Complete Scan] of the Partition, which could reduce the amount of time to 
recover data. If the results of a Partition Scan are not what you expect, restart the [> Wizard], and 
select the entire Source Drive to scan (not just the Partition).  
 
Note: Select a Partition only if you know that the data being recovered lies within that Partition. 
Otherwise, select the entire Source Drive to scan. 
 

 
____________________________________________________________ 
2. If the Source Drive is not recognized, but is attached to the computer 
 
Check the Source Drive connection to make sure it is attached properly and then restart the 
program. If the Source Drive is not recognized, contact Technical Support [Help -> Technical 
Support]. 
____________________________________________________________ 
 
3. If you forgot to attach the Destination Drive before starting the program 
 
External USB / Firewire Drive: Attach an external (USB or Firewire) Destination Drive. Close [X] 
the Wizard and then click the [> Wizard] button from the Menu Bar to restart the recovery 
process. Note: If you do not have a Destination Drive, you can attach an external USB, or 
Firewire Destination Drive (that has a FAT Partition, or that you will allow RecoverSoft™ Data 
Rescue PC to format FAT) at any time during the recovery process to save the scan of the 
Source Drive and to recover data, without having to start over. 
 
Internal Hard Disk Drive: Exit the program and shutdown the computer system. Then, attach an 
internal (IDE, EIDE, SCSI, ATA, SATA) Destination Drive and reboot the computer system with 
the program in the CD Drive to restart the recovery process. 
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5.4 Select Destination Drive 
 

 
 
4. Select a FAT Partition to save the scan and the recovered data. If a FAT Partition is not 

available, read the F1 Help notes: 
 
 
Select Destination Drive FI Help: 
 
1. What is a FAT Partition? 
2. Destination Drive Options. 
3. How to Format your Destination Drive with a FAT Partition. 
4. If you forgot to attach your Destination Drive before starting the program. 
____________________________________________________________ 
 
1. What is a FAT Partition? 
 
What is a Partition? A Partition divides storage space on any media into isolated sections, like 
desks isolate working sections within an office. To store data, each Partition (each isolated 
section) must be formatted FAT or NTFS (part of the Windows® operating system). Formatting a 
Drive with a FAT or NTFS Partition makes the Partition compatible with the Windows® operating 
system.  
____________________________________________________________ 
 
2. Destination Drive Options 
 
This program requires a Network Mapped Drive or a FAT Partition on the LOCAL Destination 
Drive (the Drive to save the scan of the problem Drive and the recovered data). By default, the 
program selects the first available FAT Partition as the Local Destination Drive. If the first 
available Drive is not the Destination Drive, click on the appropriate Drive. Click on the arrow next 
to Network Neighborhood to expand and see what network drives are available. If a FAT Partition 
is not available, read the following information: 
 
You can scan the Source Drive (the problem Drive) to view what data can be recovered, without 
having a Network Mapped Drive or FAT Partition by closing this window and then clicking the 
[Continue without Destination] button. However, to save the scan of the Source Drive, or to 
recover data, select one of the following options: 
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USB / Firewire Drive Options: Select an existing external (USB or Firewire) Destination Drive 
(that has a FAT Partition, or that you will allow the program to format FAT). Note: New USB and 
Firewire Drives both come formatted FAT. Note: If you do not have a FAT Partition or an extra 
Drive to select as the Destination Drive, scan the Source Drive without a Destination Drive. After 
viewing the files that can be recovered, attach an external (USB or Firewire) Destination Drive 
(that has a FAT Partition, or that you will allow RecoverSoft™ Data Rescue PC  to format FAT) at 
any time during the recovery process to save the scan of the Source Drive and to recover data, 
without having to start over. 
 
Internal Hard Drive Options: Select an attached internal Drive (IDE, EIDE, SCSI, ATA, SATA) 
as the Destination Drive (that has a FAT Partition, or that you will allow the program to format 
FAT). Warning: Make sure there is no data on the drive that you are choosing as your Destination 
Drive. If any data exists on the drive, it will be over-written. Note: If you do not have an attached 
internal Drive, exit the program and shutdown the computer system. Then, attach an internal 
Drive (IDE, EIDE, SCSI, ATA, SATA) as the Destination Drive (that has a FAT Partition, or that 
you will allow the program to format FAT) and restart the program.  
 
Network Neighborhood: Click the arrow ( -> ) next to Network Neighborhood to expand the 
available network drives. If the Network Neighborhood is “Empty”, press the Network Setup 
button to detect the network settings. 
____________________________________________________________  
 
3. How to Format your Destination Drive with a FAT Partition 
 
To [Format] a Destination Drive with a FAT Partition: 
 
Select the Destination Drive where you want to save the scan and the recovered data (You must 
select the entire Destination Drive to format. You cannot select a Partition to format.) Then, click 
the [Format Drive] button and then [Yes] to the question, "Do you want to format this drive now?" 
____________________________________________________________ 
 
4. If you forgot to attach your Destination Drive before starting the program 
 
External USB / Firewire Drive: Attach an external (USB or Firewire) Destination Drive. Close [X] 
the Wizard, and then click the [> Wizard] button from the Menu Bar to restart the recovery 
process. Note: If you do not have a Destination Drive, you can attach an external USB, or 
Firewire Destination Drive (that has a FAT Partition, or that you will allow RecoverSoft™ Data 
Rescue PC to format FAT) at any time during the recovery process to save the scan of the 
Source Drive and to recover data, without having to start over. 
 
Internal Hard Disk Drive: Exit the program and shutdown the computer system. Then, attach an 
internal (IDE, EIDE, SCSI, ATA, SATA) Destination Drive and reboot the computer system with 
the program in the CD Drive to restart the recovery process. 



5.5 Network Setup 
 

 
 
Network Setup F1 Help 

The Network Setup window will help you connect to a mapped network drive across your local 
area network. By default, the program will attempt to automatically fill in as much information as 
possible about your network connection when you open this window. If you are not sure of the 
values that need to be entered in the text boxes, please contact your network administrator. 
 
Network Destination 
 
Workgroup - if you know the workgroup name enter it in here. Some networks will ignore this 
field. 

Username - this is your username to log into the network. 

Password - this is your password to log into the network. 

Server List - if you know the name of the destination server or the IP address of the destination 
server you can enter it in here. It is not necessary to enter anything in this field. The program will 
browse the network and display all of the available drives that can be mapped. This is a good 
option when you are not sure which drive is the one you want to map. 

Advanced - DOS Charset - this is the character set (codepage) the network file server uses for 
filenames. 
 
TCP/IP Network (My Computer) 
 
Address, Netmask and Advanced -> Gateway – these are the values that are assigned by DHCP 
to your local computer. It is very rare that you will ever need to change this. If your network 
doesn't have DHCP turned on this field will show up blank and you will need to manually enter the 
IP address here. You will need to contact your Network Administrator for the values. 
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5.6 Scan Source Drive 
 

 
 
5. Scan the chosen Source Drive that has the data you want to recover. 
 
 
Scan Source Drive F1 Help: 
 
To recover data, a Drive or Partition must be scanned. The purpose of the scan is to find and 
rebuild the components within a file system, so that the data can be recovered and used again. 
 
The Source Drive (the problem Drive) is the Drive or Partition you have chosen to scan. 
 
The Destination Drive is the Partition on the Destination Drive you have chosen to save the scan 
of the Source Drive and the recovered data. 
 
If you have chosen the wrong Source or Destination Drive, use the [< Back] button to return to the 
appropriate screen and change your selections. 
____________________________________________________________ 
 
 
Load Scan button 
 
If you would like to use a saved scan of the Source Drive click the [Load Scan] button, and then 
select the appropriate saved scan file. Note: If you have saved a Partition Scan and the results 
are not what you expected DO NOT [Load Scan]. Select the entire Source Drive to scan (not just 
the Partition).
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5.7 Select Partition 
 

 
 
6. Select a Partition to view the data that can be recovered.  
 
 
Select Partition F1 Help: 
 
1. What is a Partition? 
4.  Select a Partition 
____________________________________________________________ 
 
What is a Partition? 
 
What is a Partition? A Partition divides storage space on any media into isolated sections, like 
desks isolate working sections within an office. To store data, each Partition (each isolated 
section) must be formatted FAT or NTFS (part of the Windows® operating system). Formatting a 
Drive with a FAT or NTFS Partition makes the Partition compatible with the Windows® operating 
system. 
 ____________________________________________________________ 
 
Select a Partition 
 
To view the recovered data within a Partition, select the appropriate Partition. If you are not sure 
which Partition has the data you want to recover, select one Partition at a time to view the data.  
 
____________________________________________________________ 
 
5.8 Raw Sector Recovery – Found Files 
 
The program now gives an option to rebuild files according to their file types (ie. DOC, XLS, MP3, 
etc).  There will be times that the damage is so severe that files that you are looking for will not 
show up in one of the partitions that you select to rebuild. If this is the case you may find the file 
by selecting the "Found Files - Raw Sectors". Word of caution: while the "Found Files - Raw 
Sectors" selection will find more files than selecting the "Partition", the validity of the files are not 
as strong and sound as selecting the "Partition". So we suggest that you choose the "Partition" 
first before trying the "Found Files - Raw Sectors" option. 
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Here are a list of the file types that the "Found Files - Raw Sectors" will find and where they will 
be seen after rebuilding: 
 
Archives/ARJ\ Files arj 
Archives/ZIP\ Files zip 
Archives/RAR\ Files rar 
Archives/Other 7z gz bz2 ace bz cab cazip sit sqx sqz stf ufa zoo lha lza marc jar j6i cru dz hap hqx 
Pictures/BMP\ Images bmp 
Pictures/GIF\ Images gif 
Pictures/JPEG\ Images jpeg 
Pictures/PNG\ Images png 
Pictures/PSD\ Images psd 
Pictures/TIFF\ Images tiff 
Pictures/WMF\ Images wmf 
Pictures/Other cam cpt mrw pcx rgb pcd fp5 crw dpx msp 
Mail/EML\ Files eml 
Mail/Other dbx pst wab snm db 
Documents/HTML\ Files html 
Documents/Excel\ Files xls 
Documents/Power\ Point\ Files ppt 
Documents/PDF\ Files pdf 
Documents/Quicken\ Files qsd qdf 
Documents/QuickBooks\ Files qbw 
Documents/Word\ Files doc 
Documents/Other rtf ai eps mny adx nsf fm3 fmt wk1 wk3 wk4 xml wri wpd ole qxd pm5 fla pub vsd mpp 
vsmacros msi rpt suo chm hlp mdb pwl 
Multimedia/AVI\ Files avi 
Multimedia/MOV\ Files mov 
Multimedia/MP3\ Files mp3 
Multimedia/WAV\ Files wav 
Multimedia/WMA\ Files wma 
Multimedia/WMV\ Files wmv 
Multimedia/Other rmi ani mid ra rm ogg riff dvm asf 
Other unknown 
 
 
 
 
 
 
 
 



5.9 Recovering Files and Folders 
 

 
 
7. To recover files and folders, follow the Recovering File and Folder F1 Help notes:  
 
 
Recovering Files and Folders F1 Help: 
 
Step 1: Determining the "Status" of the files and folders to recover. 
Step 2: Finding a specific file. 
Step 3: Selecting files and folders to recover. 
Step 4: Selecting a Destination Drive to recover files and folders. 
Step 5: Selecting the next Partition to build a new file and folder listing. 
____________________________________________________________ 
 
Step 1: Determining the "Status" of the files and folders to recover: 
 
Excellent - indicates the file should have a successful recovery. Technically, the file has valid file 
chains, and is part of the existing file system. 
 
Good - indicates the file should have a successful recovery a majority of the time. Technically, 
the file may have valid file chains, but is either not part of the existing file system, or has 
corruption within the file system. 
 
Possible - indicates the file could have a successful recovery. Technically, "Possible" and "Good" 
are equal. However, a “Possible” file is less likely to be a valid file compared to a "Good" file, 
because of possible corruption to the file.  
 
Poor - indicates the file has a poor chance of recovery. Technically, the file has invalid file chains. 
 
Yellow - indicates the file or directory has been tagged for recovery. 
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Important Note: If a folder (not file) has been renamed "Found", the original name no longer 
exists. To determine if a file within a "Found" folder can be recovered, refer to the "Status" of the 
file. Technically, if a folder has been renamed "Found", it has been found during the scan, but is 
not part of the existing file system. 
____________________________________________________________ 
 
Step 2: Finding a specific file. 
 
To find a specific file select [Options > Find File] from the Menu Bar. 
____________________________________________________________ 
 
Step 3: Selecting files and folders to recover: 
 
A. To recover individual files, right mouse click on the file. A red check-mark will appear, 
indicating the file has been tagged for recovery. Then, press the [Recover] button from the Menu 
Bar to start the recovery process. 
 
B. To recover all files and folders, right mouse click on the "Root" folder (top left-hand column of 
folder listings). A red check-mark will appear, indicating all files have been tagged for recovery. 
Then, press the [Recover] button from the Menu Bar to start the recovery process. Note: If a file 
cannot be located, try searching in another Partition, if available (See Step 5). 
 
C. To recover files by mask (to recover specific file types, like .txt files), select [Options > Select 
by Mask] from the Menu Bar and refer to the example. 
____________________________________________________________ 
 
Step 4: Selecting a Destination Drive to recover files and folders: 
 
A. External USB/Firewire Drive: If you did not have a Destination Drive with a FAT Partition, you 
can attach an external USB, or Firewire Destination Drive (that has a FAT Partition, or that you 
will allow RecoverSoft™ Data Rescue PC to format FAT) at any time during the recovery process 
to save the scan of the Source Drive and to recover data, without having to start over.  
 
Once the USB or Firewire Destination Drive is attached, select [Options > Select Destination] 
from the Menu Bar to select the Destination Drive you want to use. Note: If the Destination Drive 
needs to be Formatted FAT, use the [Format Drive] button within the Select Destination window. 
 
B. Internal Hard Disk Drive: If you did not have a FAT Partition, or an extra Drive to select as the 
Destination Drive at the beginning of the program, and you only have an internal Drive to use as 
the Destination Drive (to recover data): 
 
Exit the program and shutdown the computer system. Then, attach an internal drive as the 
Destination Drive that has a FAT Partition (or that you will allow the program to format FAT), and 
restart the program. Note: So that the Source Drive does have to be re-scanned when re-
entering the program, save the scan to a floppy diskette before exiting RecoverSoft™ Data 
Rescue PC . If this is not possible, the drive must be re-scanned.  
____________________________________________________________ 
 
Step 5: Selecting the next Partition to build a new file and folder listing: 
 
To select a different Partition from the Select Partition Window to build a new file and folder 
listing, select [Options > Select Partition] from the Menu Bar. 
 
 
 
 
 
 
 
 



5.10 Accessing the Recovered Data 
 
1. To view and use the recovered data, the Destination Drive should be attached to a working 

Windows computer system.  
 

 

Warning: Access and test the validity of the recovered data, before discarding the 
Source Drive. 
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Chapter 6 Frequently Asked Questions (FAQ) 
 
6.1 Standard FAQ 
 
a. How does RecoverSoft™ Data Rescue PC differ than other data recovery utilities? / p.22 
b. Will RecoverSoft™ Data Rescue PC recover my Word documents? Excel? (Microsoft® 

Office)? / p.22 
c. Can RecoverSoft™ Data Rescue PC recover my digital pictures? music? videos? / p.22 
d. I accidentally deleted a file. / p.22 
e. Can RecoverSoft™ Data Rescue PC work on my computer? / p.22 
f. Can RecoverSoft™ Data Rescue PC recover from Windows XP? / p.22 
g. If I have a problem, is there Technical Support? / p.22 
h. How do I burn a bootable CD? / p.23 
i. What do you mean by setting the BIOS to boot from the CD Drive? / p.23 
j. How do I know RecoverSoft™ Data Rescue PC will recover my data? / p.24 
k. How do I purchase RecoverSoft™ Data Rescue PC? / p.24 
l. How do I register RecoverSoft™ Data Rescue PC? / p.24 
m. Why can’t I recover data to my problem Drive? / p.24 
n. When I open a file, the content looks distorted / p.24 
 
6.2 Advanced FAQ 
 
a. I accidentally formatted my hard drive. / p.25 
b. I used FDISK and can’t access my data. / p.25 
c. I deleted a Partition using FDISK (Partition Magic, etc). / p.25 
d. I re-installed Windows and lost all my data. / p.25 
e. I used Ghost and my data is gone. / p.25 
f. I got hit by a virus. / p.25 
g. CMOS and FDISK do not recognize my drive. / p.25 
h. What operating systems are supported? / p.25 
i. What types of media are supported? / p.26 
j. Can I recover over a network? / p.26 
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6.1 Standard FAQ 
 
 
a. How does RecoverSoft™ Data Rescue PC differ than other data recovery utilities? 
 
Unlike Windows-dependent data recovery software, RecoverSoft™ Data Rescue PC does NOT 
require the Windows operating system to run. This means, NO software installation, computer 
disassembly or boot diskettes are required to set-up and run RecoverSoft™ Data Rescue PC.  
 
Simply, insert the RecoverSoft™ Data Rescue PC  CD and reboot your computer. RecoverSoft™ 
Data Rescue PC automatically and safely boots from the RecoverSoft™ Data Rescue PC  CD to 
access your media, even when you cannot boot to the Windows® desktop. RecoverSoft™ Data 
Rescue PC then guides you to scan the problem media, select the files to recover, and recover 
the files to an external USB / Firewire device (or hard disk drive). 
 
Second, RecoverSoft™ Data Rescue PC recovers files when a file or file system has been 
altered, deleted, lost or damaged. Undelete Software cannot recover files when the file system 
has been altered, deleted, lost or damaged by Windows®, a virus, or another utility.  
 
b. Will RecoverSoft™ Data Rescue PC recover my Word documents? Excel? (Microsoft® 

Office)? 
 
If you recently lost the file and it has not been over-written by other data or damaged, 
RecoverSoft™ Data Rescue PC can recover them. 
 
c. Can RecoverSoft™ Data Rescue PC recover my digital pictures? music? videos? 
 
If you recently formatted the media, or deleted the pictures (music, and videos), and they have 
not been over-written by other data or damaged, RecoverSoft™ Data Rescue PC can recover 
them. 
 
d. I accidentally deleted a file. 
 
If you recently deleted the file and it has not been over-written by other data or damaged, 
RecoverSoft™ Data Rescue PC can recover them. 
 
e. Can RecoverSoft™ Data Rescue PC work on my computer? 
 
If your operating system is Windows®, your computer system meets the minimum System 
Requirements, and your media is supported, RecoverSoft™ Data Rescue PC will work. 
 
f. Can RecoverSoft™ Data Rescue PC recover from Windows XP? 
 
Yes. RecoverSoft™ Data Rescue PC supports all Microsoft® Windows® operating systems. 
 
g.  If I have a problem, is there Technical Support? 
 
Yes. Support is available before and after you purchase any of our products. Visit our website for 
the most current Downloads, Manuals, and Frequently Asked Questions: 
 
Website: http://www.RecoverSoft.com  
Frequently Asked Questions (FAQ) – See Chapter 6.   
Phone: 1-925-426-6306. 
Technical Support Hours: Monday – Friday 8:00 A.M. – 5:00 P.M. (P.S.T.). 
 
 
 
 
 
 
 

http://www.recoversoft.com/
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h. How do I burn a bootable CD? 
 
Download RecoverSoft™ Data Rescue PC online: http://www.RecoverSoft.com
 
Windows XP or 2003: 
 
1. If you are downloading to Windows XP or 2003, then download the file ending in 

RecoverSoftDRPC.exe and save it to your desktop.  
2. Double-click RecoverSoftDRPC.exe on your desktop and this will launch the RecoverSoft 

Data Rescue PC CD Writer. The screen will say, “This program will create a bootable 
RecoverSoft Data Rescue PC CD. To proceed, you will need a blank recordable CD, and 
your computer must be equipped with a CD Writer. This program is compatible with Windows 
XP or 2003 only. If you have an earlier operating system, or do not have a CD writer and 
blank CD, press ‘Cancel’ to exit.” 

3. Click ‘OK’ to continue. 
4. WinZip Self-Extractor – RecoverSoftDRPC.exe screen will appear. It says, “To proceed, 

make sure there is a blank CD in your CD writer, then click ‘Setup’, or click ‘Cancel’ to exit. 
5. This will now create a bootable CD. 
6. Insert the RecoverSoft™ Data Rescue PC  CD into the failing computer as soon as the 

computer starts booting, so that the computer boots from the RecoverSoft™ Data Rescue PC 
CD (If the computer has already been booted, insert the RecoverSoft™ Data Rescue PC  
CD, and then reboot the computer). 

 
Other Windows Operating Systems: 
 
1. If you are downloading to an operating system other than Windows XP or 2003, then you 

must download the version of the software ending in RecoverSoft.iso and save it to your 
desktop. 

2. How to burn a bootable CD: Windows® cannot burn a bootable CD. Computers with a CD-R 
(CD-Recordable) or CD-RW (CD-Rewritable) Drive have CD burning software that can burn a 
bootable CD preinstalled on the computer [Check your computer: Start button (bottom left-
hand corner of the screen) > Programs > (Nero® and Roxio® are the most popular].  

3. Nero® step-by-step directions (This program is free unless Nero® is updating the Demo): 
a. Download NERO® 6 Trial Version: 

http://www.nero.com/us/download_demo.php?pak=1  
b. Save NERO® to the desktop. 
c. Double-click the NERO® file on the desktop. 
d. Insert a new CD in the CD Drive of the computer. 
e. Double-click the “Nero Start Smart” icon on the desktop. 
f. Double-click the image of 2 CDs (“Copy and Backup”). 
g. Double-click “Burn Image to Disk”. 
h. Click [Demo] on the pop-up window, and then click [OK] to the next pop-up window. 
i. A Windows® window appears. Locate the RecoverSoft™ Data Rescue PC  ISO 

Image (Downloaded at RecoverSoft.com and most likely saved to the desktop). 
Highlight the file, and click [Open]. 

j. Confirm the “Image File” and the “Destination Drive”, and then click [> Next] to start 
the burning process. 

k. Insert the RecoverSoft™ Data Rescue PC  CD into the failing computer as soon as 
the computer starts booting, so that the computer boots from the RecoverSoft™ Data 
Rescue PC CD (If the computer has already been booted, insert the RecoverSoft™ 
Data Rescue PC  CD, and then reboot the computer). 

 
i. What do you mean by setting the BIOS to boot from the CD Drive? 
 
All computers have a BIOS to help computer software communicate with computer hardware. 
The computer BIOS must be set to boot from the CD Drive so that RecoverSoft™ Data Rescue 
PC can communicate with the computer hardware. If you have problems setting the BIOS contact 
Technical Support. 
 
 
 

http://www.recoversoft.com/
http://www.nero.com/us/download_demo.php?pak=1
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j. How do I know that RecoverSoft™ Data Rescue PC will recover my data? 
 
Each file is given a specific “Status”, which determines the rate of recovery. Standard Mode 
Users can easily follow the color-coding “Status”, while Advanced Mode Users can read the 
“Technical Information”.   
 
k. How do I purchase RecoverSoft™ Data Rescue PC ? 
 
RecoverSoft™ Data Rescue PC can be purchased online: http://www.RecoverSoft.com. 
 
l. How do I register RecoverSoft? 
 
A purchased version of RecoverSoft™ Data Rescue PC  has a Registration Code within the CD 
case of the box you purchased RecoverSoft™ Data Rescue PC , and are waiting for the box, but 
need to use the product immediately, the following registration options are available:  
 
Online Registration: a Registration Key is sent via e-mail after your purchase.  
Phone Registration: 1-800-4-PROSOFT (if you only have one computer). 
Registration Hours: Monday – Friday 9:00 A.M. – 6:00 P.M. (P.S.T.) 
 
m. Why can’t I recover data to my problem Drive? 
 
Data cannot be recovered to the problem Drive, because the data being recovered will over-write 
data that still needs to be recovered. Doing this can also cause corruption to the file system, 
making your data permanently unrecoverable. 
n. When I try to open a file, the content looks distorted. 
 
If the content of a file shows distorted, call Technical Support for additional options. The cause 
could be over-written data, viruses, etc. 
 

http://www.recoversoft.com/
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6.2 Advanced FAQ 
 
 
a. I accidentally formatted my hard drive. 
 
A Windows Quick Format can be recovered if the data has not been over-written or damaged. A 
Windows Full Format low-level formats every sector. Therefore, all data most likely will be 
destroyed (Exception: Windows 95, 98, and ME format function acts as a Quick Format. 
Therefore, it can be recovered if the data has not been over-written or damaged). 
 
b. I used FDISK and can’t access my data. 
 
FDISK resets the partition and boot sectors, but does not affect the data. Therefore, 
RecoverSoft™ Data Rescue PC can recover the data. 
 
c. I deleted a Partition using FDISK (Partition Magic®, etc). 
 
FDISK (and other partitioning utilities) resets the partition and boot sectors, but does not affect 
the data. Therefore, RecoverSoft™ Data Rescue PC can recover the data.  
 
d. I re-installed Windows and can’t access my data. 
 
If the data has not been over-written or damaged by re-installing Windows®, RecoverSoft™ Data 
Rescue PC can recover it. 
 
e. I used Ghost and my data is gone. 
 
If the data has not been over-written or damaged by re-installing Windows®, RecoverSoft™ Data 
Rescue PC can recover it. 
 
f. I got hit by a virus 
 
If the virus has not physically damaged the files data, RecoverSoft™ Data Rescue PC  can 
recover it. 
 
If you have one of these error messages when booting: 

 
‘INVALID DRIVE SPECIFICATION’ or ‘MISSING OPERATING SYSTEM’, 

 
a virus has probably infected the Boot Sector and/or Partition Table, while leaving the rest of your 
file system intact. Therefore, RecoverSoft™ Data Rescue PC can recover the data.  
 
g. CMOS and FDISK do not recognize my drive. 
 
If RecoverSoft™ Data Rescue PC cannot access or recover your data, your media has severe file 
corruption or is mechanically failing (software will not solve your problem at this point). This 
means, your Drive should be evaluated by professional data recovery personnel. RecoverSoft™ 
recommends contacting ACR Data Recovery™ for In-Lab Data Recovery Services. Visit their 
website for more details: http://www.ACRdatarecovery.com, or contact them by telephone:  
1-800-444-3225 or 1.770.925.4420. 
 
h. What operating systems are supported? 
 
RecoverSoft™ Data Rescue PC supports all Microsoft® Windows® operating systems. 
 
 
 
 
 
 
 

http://www.acrdatarecovery.com/
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i. What types of media are supported? 
 
RecoverSoft™ Data Rescue PC supports Firewire and USB Devices (Compact Flash Type I, II, 
Microdrives, Smart Media, Secure Digital Cards, Memory Sticks, XD-Picture Cards, etc.), Zip, 
Jaz, Floppy Diskettes, and hard disk drives (IDE, EIDE, SCSI, ATA, SATA). 
 
j. Can I recover over a network? 
 
Coming soon! We are programming network capabilities as you read this. Register your copy of 
RecoverSoft™ Data Rescue PC online and you will receive program updates as they are 
released.  
 



7.0 ACR Data Recovery™ Services 
 
If RecoverSoft™ Data Rescue PC cannot access or recover your data, your media has severe file 
corruption or is mechanically failing (software will not solve your problem at this point). This 
means, your Drive needs to be evaluated by professional data recovery personnel. 
RecoverSoft™ recommends contacting ACR Data Recovery™ for In-Lab Data Recovery 
Services. Visit their website for more details: http://www.ACRdatarecovery.com, or contact them 
by telephone: 1-800-444-3225 or 1.770.925.4420. 
 
 
About RecoverSoft™ 
 
RecoverSoft™ is a wholly-owned subsidiary of Prosoft Engineering, Incorporated. 
 
Established in 1985, Prosoft Engineering, Inc. specializes in creating professional quality software 
designed to be easily used by both novice and expert users. Prosoft's lines of networking and 
utility software products are engineered to empower users to effectively manage their data.  
Prosoft Engineering, Inc. is headquartered in Pleasanton, CA.  Please visit the website at 
http://www.prosofteng.com. 
 
 
 

™ 
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RecoverSoft™ Data Rescue PC License Agreement 
 
READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT CAREFULLY 
BEFORE RUNNING THE COMPUTER SOFTWARE HEREIN, AND THE ACCOMPANYING 
USER DOCUMENTATION (THE "PROGRAM"). THE PROGRAM IS COPYRIGHTED AND 
LICENSED (NOT SOLD). BY RUNNING THE PROGRAM, YOU ARE ACCEPTING AND 
AGREEING TO THE TERMS OF THIS LICENSE AGREEMENT. IF YOU ARE NOT WILLING TO 
BE BOUND BY THE TERMS OF THIS LICENSE AGREEMENT, YOU SHOULD PROMPTLY 
DELETE THE SOFTWARE AND ACCOMPANYING FILES. THIS LICENSE AGREEMENT 
REPRESENTS THE ENTIRE AGREEMENT CONCERNING THE PROGRAM BETWEEN YOU 
AND PROSOFT ENGINEERING, INC. (REFERRED TO AS "LICENSOR"), AND IT 
SUPERSEDES ANY PRIOR PROPOSAL, REPRESENTATION, OR UNDERSTANDING 
BETWEEN THE PARTIES. 
 
License Grant.   Licensor hereby grants to you, and you accept, a nonexclusive license to use the 
Program Diskette/CD and the computer programs contained therein in machine-readable, object 
code form only (collectively referred to as the "Software"), and the accompanying User 
Documentation, only as authorized in this License Agreement. You agree that you may not 
reverse assemble, reverse compile, or otherwise translate the Software. 
 
Licensor's Rights.   You acknowledge and agree that the Software and the User's Manual are 
proprietary products of Licensor protected under U.S. and International copyright law. You further 
acknowledge and agree that all right, title, and interest in and to the Program, including 
associated intellectual property rights, are and shall remain with Licensor. This License 
Agreement does not convey to you an interest in or to the Program, but only a limited right of use 
revocable in accordance with the terms of this License Agreement. 
 
License Fees.   The license fees paid by you are paid in consideration of the licenses granted 
under this License Agreement. If you received the software for demonstration purposes and/or no 
fee was charged, this in no way effects the terms of this agreement. The license fees for the 
unlimited drive version are paid on an annual basis from date of purchase. The license fees for 
the limited drive version are incurred only once at time of purchase. 
 
License Type.    (A) End User Edition (Single Copy of Software) - Valid for an Individual to use a 
Single Copy of the Software on all computers that he/she owns for non-commercial use. License 
is bound to a Single CD-ROM, so you cannot run multiple copies of the software at a given time 
without purchasing more licenses. Your back-up copy is your CD Key, so do not lose it. (B) IT 
Edition (Single Copy of Software) - Valid for an Individual to use a Single Copy of the Software on 
any computer in any location for his/her commercial use. Also, valid for a Group to use a Single 
Copy of the Software on any computer that the Group owns in a single location for commercial or 
non-commercial use. License is bound to a Single CD-ROM, so you cannot run multiple copies of 
the software at a given time without purchasing more licenses. Your back-up copy is your CD 
Key, so do not lose it. 
 
Term.   This License Agreement is effective upon your receiving the software, either on disk or by 
electronic transfer of any type and shall continue until all copies of the software have been 
returned to Licensor. You may terminate this License Agreement at any time by returning the 
Program and all copies thereof and extracts therefrom. Licensor may terminate this License 
Agreement upon the breach by you of any term hereof. Upon such termination by Licensor, you 
agree to return to Licensor the Program and all copies and portions thereof. 
 
No Warranty. The software is supplied without any warranty. THE PROGRAM, AND THE 
SOFTWARE CONTAINED THEREIN, ARE LICENSED "AS IS," AND LICENSOR DISCLAIMS 
ANY AND ALL OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING, 
WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE. 
 
Limitation of Liability.   Licensor's cumulative liability to you or any other party for any loss or 
damages resulting from any claims, demands, or actions arising out of or relating to this 
Agreement shall not exceed the license fee paid to Licensor for the use of the Program . In no 
event shall Licensor be liable for any indirect, incidental, consequential, special, or exemplary 
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damages or lost profits, even if Licensor has been advised of the possibility of such damages. 
SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR 
EXCLUSION MAY NOT APPLY TO YOU. 
 
Trademark.  RecoverSoft™ is a trademark of Prosoft Engineering, Inc. No right, license, or 
interest to such trademark is granted hereunder, and you agree that no such right, license, or 
interest shall be asserted by you with respect to such trademark. 
 
Governing Law.   This License Agreement shall be construed and governed in accordance with 
the laws of the State of California, U.S.A. 
 
Costs of Litigation.   If any action is brought by either party to this License Agreement against the 
other party regarding the subject matter hereof, the prevailing party shall be entitled to recover, in 
addition to any other relief granted, reasonable attorney fees and expenses of litigation. 
 
Severability.   Should any term of this License Agreement be declared void or unenforceable by 
any court of competent jurisdiction, such declaration shall have no effect on the remaining terms 
hereof. 
 
No Waiver.   The failure of either party to enforce any rights granted hereunder or to take action 
against the other party in the event of any breach hereunder shall not be deemed a waiver by that 
party as to subsequent enforcement of rights or subsequent actions in the event of future 
breaches. 
 
© 2005 Prosoft Engineering, Inc. All rights reserved. RecoverSoft™ Data Rescue PC and the 
RecoverSoft™ logo are trademarks of Prosoft Engineering, Inc. 
© 2003 – 2005 ACR Data Recovery, Inc.™   
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